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About SW FEAD

SW FEAD (Finite Element Analysis and Design) is a free structural analysis and design software for the
analysis and design of buildings. The software can be used for three-dimensional static and dynamic
analysis of buildings for earthquake loading based on the NBC 105:2020 and IS 1893:2016 standards.
The software is also capable of design of reinforced concrete beams and columns, as well as drawing
generation.
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Features

Structural Modeling

e Structures can be modeled using frame, slab, masonry infill walls and concrete wall elements

e Frame elements can be modelled based on Euler-Bernoulli or Timoshenko beam theories

e Masonry infill walls modeled according to IS 1893:2016 provisions

e Elements can be drawn graphically in 3D or section views

e Building frame structures may be generated based on user defined size and number of bays
and storeys

e Different support conditions can be assigned to nodes

e Reinforced concrete and steel sections are supported. Automatically calculates all required
geometrical properties based on section dimensions.

e Support for flexural and shear stiffness modifiers

Load Combinations

e Pre-defined load cases for dead load, live load, storage live load and earthquake load (X and
Y direction)

e Load combinations can be automatically generated based on NBC 105:2020 and IS
1893:2016 standards.

e Concentrated and distributed loads may be assigned to frame elements, and uniform area
loading may be applied to slabs.

Earthquake Loading and Analysis

e Automatically computes earthquake loads based on the NBC 105:2020 and IS 1893:2016
standards.

e Seismic analysis can be performed using the Seismic Coefficient Method or the 3D Modal
Response Spectrum method

e Display axial force, shear force and bending moment diagrams, as well as deformations.

e Mode shape display and animation

Reinforced Concrete Design and Drawing

e Automatically performs the limit state design of reinforced concrete beams and columns for
axial, shear, bending and torsion.

e Performs ductile design based on the NBC 105:2020 or IS 13920:2016 standards. Design
based on the IS 456:2000 standard is also supported.

e Computes and displays the required rebar percentage in all reinforced concrete members

e Aninteractive design mode to assign reinforcement bars to members

e Automatic detailing feature to auto-assign rebar number and spacing based on user-
specified bar sizes

Drawing Generation

e Generates L-Section and X-Section drawings of beams and columns
e Drawings are exported to the AutoCad DXF format and can be edited or printed from any
compatible CAD application



System Requirements

e Operating System: 64-Bit Windows 7 or later (Windows 10 Recommended)
e Processor: Dual Core 2.5 GHz (Quad Core 3 GHz+ recommended)

e Memory: 4 GB (8GB recommended)

e Disk space: 1.0 GB.

e Graphics: DirectX 10 Capable

Installation
To install SW FEAD, follow the instructions below.

e Register an account with Softwel. You can register an account from the Softwel official page.

e Once you register, an e-mail will be sent to you containing the activation link. Click on the
link to sign in and activate your Softwel account.

e Go to the Downloads page of Softwel.

e Download the SW FEAD Setup File and run it.

e Once installed, you can start SW FEAD from your desktop or the start menu. You will be
required to sign in on the first run. Once signed in, you can run the software offline.

@ Sign In to Softwel >
Sign In mwel
Ernail
Password

Login
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1 User Interface

1.1 The Startup Screen
When SW FEAD is first opened, the following startup screen is displayed.

G swreap - O X
File Edit View Draw Define Assign Analyze Design Output Display Help
eEH2¢ @aa® @ A0 kK| sei- @ @ Qs 30 5eC| P b xv vz xz |GRID Ry

Recent Projects
New Project
Test

C:\Users\Avinab\Documents\FEAD\Test.sfe

Open Project

sNAP | OSNAP | NONE | Status

The startup screen shows a list of recent projects, and buttons for creating a new project or opening
an existing project. Once a project is created or opened, the structure model view is shown and the
disabled menus and tools are available.



1.2 Main Window

The main window is shown after a project is loaded. The window is divided into the following

components.

e Menus and Toolbars

e View Windows

e Properties and Options Panel
e Qutput Panel

e Status Bar

e User Login Information

G SWFEAD: C —

Fle Edit View Draw Defipe Assign Anahge Design Output Disglay Help

DA Faa® Al SLBX ss- © @ @as 30sec P b Xy vZxz | GRID | 12DL - 151+ 15LL(5)

I Menu and Toolbar

3D View Bl YZ PLANE AT X=0

F  Properties >4

Selection Properties
View Options

Output

11:43:50.301 Opening file C:\Users\Avinab\Documents\FEAD\Test.sfe
11:43:51.168 Opening file complete.

Output and Logs

Praeemes Of plicns

snap | 0sNAP | NONE | Loaded CAUsers\Avinab\Documents\FEAD\Test.sfe

1.2.1 Main Toolbar

The main toolbar contains various tool buttons which have their respective functions as show in

figure below.

File Edit View Draw Define Assign Analyze Design Output Display Help

PeaeA2dEgaa®e A 0 kB XK sele @ @ © s 30 S| P L XY ¥Z Xz GRID | 1.2DL + 1.5LL + 15LL(S)

-

Lock/Unlock Model j

Draw Line Element
Draw Area Element
Break Element
Add/Edit Support
Join Element
Delete Support

Run Analysis j

Load Combination
Grid
Plane

Move up and down
View

Element Section

Diagrams



1.2.2 View Windows

These windows are used to view the model in 3D view and different section planes (XY, YZ, ZX).

3D View

1.2.3 Properties

It is used to display the properties of the selected items (Node, Line, Area). The properties of
selected items can be modified here. When multiple items of the same type are selected, this panel
shows the common properties of the selected items, and any change is applied to all the selected

items.

Selected Element

Element ID

Element Properties

Properties

Slab Properties
ID

Slab Section

Live Load (kN/m?)
Storage Live Load (kN/m®)

Imposed Dead Load (kN/m?)

-1
8

sLaB
3
0
0




1.2.4 Options
The option panel controls what is displayed on the viewports. It allows turning on and off the
visibility of the model’s components and other information.

The visibility of some components depends on the visibility of other components. For example, node
texts may not be shown if node symbols are invisible. Similarly, element text and section information
cannot be shown if elements are not shown.

vy

Display Options for Node |

Show Node Supports

Elements
Show Element

; . Show EI t Text
| Display Options for Elements I L] Show Element T

¥y

[] Show Element Section
[ ] Show Extruded Section

Slabs

| Display Options for Slabs I £ show Slab Panel
[[] Show Slab Section

Walls
Show Wall Panel

[C] Show Wall Section

. 4

| Display Options for Walls I

Loads
Show Load Value

[C] Show Member Dead Load
[C] Show Slab Load

Show Point Load

Show External UDL

 J

Display Options for Loads I

1.2.5 Status Bar

The status bar shows the current snapping and selection mode, as well as the number of elements
selected. When running an analysis, the status bar shows the progress of the analysis. When
updating the application, the update progress is also shown here.

ALL | 13 Modes, 16 Elements Selected

SNAP | OSNAP

1.2.6 User Login Information

The current user login information is shown on the top right corner of the window. To sign out and
sign in as a new user, you may click the email address and on the dropdown that follows, click “Sign
Out”.

— O x

Sign Qut '

4




1.3 Creating a New Project
To create a new project, follow the steps below.

1. Open the New Project Window. This can be done from the startup screen, the toolbar or the

File menu.

2. Select the seismic analysis building code to be used for the model.
3. Select whether you wish to automatically add the floor slabs and the default load

combination.

4. Enter the size of bays, in meters, in the respective columns in the grid. For example, if the
building has two bays in the X direction having size 3m and 4m, enter 3 and 4 in two rows in
the X column. Alternatively, you may also click Blank Template to create a model without

any elements.
5. Press OK and select the path to save the new project.

@ New Project

Seismic Code | NBC 105:2020

Add Slabs | NBC 105:2020

Add Defaul 15 1893:2016

Bays

X

Wow W e

3
3
3

Woow Wy

Reset

35FPS

Cancel Blank Template oK



2 Main Menu

The entire system is grouped into menus based on their similarity of functions. The following table

provides the summary of the menus and the subsequent section provides details of each of the

menus and the sub-menus.

File Edit View Draw Define Assign Analyze Design Output Display Help

NeE2CEe a®

G770 Ik B¥ s © @ ©cs dsec d 4| vzxz GRD | 1200+ 150 + 15LL(S)

Ty

Menu Description
File Allows users to create new project, open project, save and save as
project, close project and exit.
Edit Edit data related to nodes and elements; delete, join and replicate
elements; allows selection of all elements.
. Handling of zoom options in selected View Window; Selection of 3D
View . . . . . . .
View window or Sectional View Window; Element Properties Viewer
Draw Node elements by inserting Coordinates or breaking existing
Draw element; Draw Line elements (beam or column) by connecting two
nodes; Draw supports and slab panels.
Define This section allows to define materials, sections, loading and
diaphragm constraints.
Assign Helps to assign selected element either as column or beam or slab
& element.
Analyze Checks the error in the model and performs analysis.
Design Design of reinforced concrete beams and columns.
Outout Gives output of different types of loads and members in table and
P drawing form.
. Options for displaying the results of analysis such as reactions, shear
Display .
forces, bending moments, deformed shapes, mode shapesetc.
Help Provides info about the system and available updates.




3 The SW FEAD Viewport

The viewport shows the 3D view or a sectional view of the currently open model and allows the user
to interact with it. It also shows the analysis and design results.

3D View Rl Y7 PLANE AT X=0

3.1 Switching 3D/2D views

The active viewport may be switched to the 2D section view by pressing one of XY, YZ or XZ buttons
on the toolbar. To load a section with a specific node or element, press the SEC button. When in
section view, click the Up and Down arrow buttons on the toolbar to move the view plane forward
and back.

G Section View *
Section By

® Mode |0 v

) Element

View Plane

® XY Plane

) Y7 Plane
() Z¥ Plans

Cancel OK




3.2 Pan, Rotate and Zoom
To pan the view, hold the middle mouse button (Scroll wheel) and then move the mouse.

To rotate the 3D view, you may use one of the following three options.

Double left-click at the anchor point of rotation, then move the mouse.
Hold Shift and the left mouse button, then move the mouse.

3. Click the Rotate tool on the toolbar to activate rotate mode, then move the mouse holding
the left mouse button.

To zoom infout, you may use the mouse wheel or the toolbar buttons. Double-clicking the middle
mouse button will zoom the view to its extents.

3.3 Selection
SW FEAD has 5 selection modes available.

None: Nothing can be selected

Node: Node points can be selected

Line: Line Elements (such as beams and columns) can be selected
Area: Area elements (slabs, infill and RC walls) can be selected

vk wN R

All: Everything can be selected

Selection mode can be changed from the right click context menu of the viewport, or the toolbar.

:*‘.IE:I_‘ l 1
- F 3
- — = 1 1 S oo K| el |© @ @ cs|3psec A I

| Select » None MNone

Clear Selection Mode I Node W
= Line Element Line
=
Area Element Area

= All All
- | |

When in a selection mode, the selectable items may be selected or unselected by left clicking on
them. To select multiple items with a box selection, hold the Ctrl key and then drag while holding
the left mouse button.

You may clear selection by pressing the Esc key. Pressing Esc when nothing is selected changes the
selection mode to None.

3.4 Adding/Removing a Viewport

When SW FEAD is started, the current model is shown in two viewports.

A viewport may be added by using the View->Add Viewport menu. To remove a viewport, press the
Xicon next to the viewport title.

Viewports may be dragged around and undocked from the main window by dragging the title bar.



4 The File Menu

File menu has the following options available.

6 SW FEAD: DASW_FEAD _TEST_FILESY
File | Edit View Draw Define A

T New Ctrl+N
27 Open Ctrl+O
H Save Ctrl+5
B savess. Fi11
X Close Project

Recent Projects k
G | Edat

4.1 New

Opens the window for creating a new project.

4.2 Open

Open an existing project.

4.3 Save

Save the currently open project.

4.4 Save As

Save the currently open project in a new file and continue in it.

4.5 Close

Closes the current project.

4.6 Recent Projects
Display the list of recently opened projects for quick opening of the project file.

4.7 Exit
Exits the application.



5 Edit

Edit | View Draw Define Assign Analyze Design Out

a | Frame Data k MNodes

Delete Support Elements

Join Elements
Replicate Floor
Undo Ctrl+Z

Redo Ctrl+Y

25

Select All Ctrl+A

5.1 Frame Data
The Edit Frame data menu allows editing the nodes and line elements in the model.

5.1.1 Nodes
Edit nodes present in the model. Here the coordinates of every node present in the model are
displayed in increasing order of their id. The node coordinates can be edited here.

G Nodes >
ID X ¥ z
0 0 0 0 ~
1 0 3 0
2 0 6 0
3 0 9 0
4 3 0 0
5 3 3 0
6 3 6 0
7 3 9 0
8 6 0 0
g 6 3 0
10 6 6 0
11 6 9 0
12 g 0 0
13 g 3 0 y
Cancel OK

10



5.1.2 Line Elements
This menu displays a table that allows you to view and edit the connectivity of the line elements in

the model.
4 Elements — O et
D From To
1] 0 16
1 16 32
2 32 A3
3 1 17
4 17 33
5 33 49
] 2 18
7 13 34
] 34 50
Cancel QK

5.2 Delete Support

Clicking this menu will delete supports from the nodes that have been selected in the model.

5.3 Join Elements

This sub-menu is used to join elements of the model by deleting nodes. To join two elements
connected by a node, press this menu or the join icon on the toolbar and then click the node
common between the two elements to be joined.

5.4 Replicate Floor
This command copies the property from one floor element to another floor.

5.5 Undo and Redo

The undo command reverses the last command while redo command repeats the last un-done
command.

5.6 Select All

This selects all the items that can be selected in the current selection mode.

11



6 View

View | Draw Define Assign Analyze Design Output Displa

I| & Foom | @ | Extent
3D View # | Zoom In
Section View =, | Zoom Out
Add Viewport Zoom At Node

Element Properties Zoom At Element ™

Refresh / |

6.1 Zoom

There are various zoom related commands under this menu which allows you to perform a particular
zoom action in the selected view window such as zoom to extent, zoom in, zoom out, zoom at node,
zoom at element.

6.2 3D View

Clicking this menu will load the 3D view in the current viewport.

6.3 Section View
This window lets the user display either XY, YZ or ZX plane in the currently selected viewport.

@ Section View >
Section By

® Mode 0 v

) Elernent

View Plane

®) XY Plane

) YZ Plane
() Z¥ Plane

Cancel QK

6.4 Add Viewport

This command adds a new viewport in the main window.

12



6.5 Element Properties

The following shows element properties dialog box:

N g

Element | 90 ©

Member Geometry | Section Properties

Load Combination | 1.50L + 1.5LL + 1.5LL(S) =

Force Diagram | Deflections

Distance 0.716
Value -0.00049

Deflection Direction
) Deflection ¥

@ Deflection Z
() Slope Y
] Slope Z

Deflection Type

® Absolute

) Relative to member ends

Distance
0
0.3
0.6
0.9
1.2
15
1.8
2.1
24
27
3

49

Value (mm)
-0.308
-0.383
-0.46
-0.528
-0.578
-0.607
-0.614
-0.606
-0.591
-0.583
-0.599

Various properties of the selected element such as geometrical, sectional is displayed as well as

force diagram and deflections as per loading are displayed.

6.6 Refresh

This menu will refresh and redraw all the viewports.

13



7 Draw

Define Assign Analyze Design Output Display

q Element A o L8 cn.
| Mode 4 MNode by Coordinates
- Support Break Element
Slab Panel

7.1 Node

This sub menu has two options for drawing nodes:

7.1.1 By Coordinates
By manual entry of coordinates of the node in the window shown below, one can draw a node.

7.1.2 Break Element
This command inserts a new node between two existing nodes of a line element.

7.2 Support

This sub-menu is for drawing support. Here the node which was selected to insert support is
displayed. The support type and restraints must be selected prior to inserting support at the selected
node.

3 supports =
Modes 48

Support Type

(® Fixed ) Roller
) Simple ) Custom
) No Support

Restraints About Global Axes

+| Translation X +'| Rotation X
+| Translation ¥ +| Rotation Y
+| Translation Z +'| Rotation Z

Cancel OK

7.3 Line Element
This sub-menu is a tool to draw a line element by selecting any two nodes in the current view

window.
Draw Element n
Element Type
Slab -
Section
SLAB -

7.4 Area Element

This sub-menu is for the drawing of area elements (slabs, infill walls and RC walls). After selecting the
section as defined in the Define menu, nodes in the current window view must be clicked to draw
the element.
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8 Define

8.1 Material

This tool is used to define a material. The material may be either concrete or steel, and the engineering
properties such as elastic properties, shear modulus and unit weight may be assigned or generated
automatically based on the grade of the material. The materials defined here has to be assigned to a

Define | Assign  Analyze Design

Materials
Beam/Column Sections
Slab Sections

Infill Wall Sections

RC Wall Sections

Seismic Loading

Load Combinations
MNode Loads

Element Loads
Diaphragm Constraint

beam/column section, slab section or RC wall section to be used in the model.

6 Materials

Material List

M20

Delete

Mew

Material Type
® Concrete

) Steel
Mame M20

Concrete Grade M20
Rebar Grads Fe500

Elastic Modulus, E
Shear Modulus, G

Unit Weight

Generate Properties

22360680 kN/m®

0216050 kN/m*

25 kN/m®

Apply Close
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8.2 Beam/Column Sections

This menu opens a list of currently defined section and allows you to add new sections and edit/delete
the existing sections.

4 Element Sections — O X
Section List

BEAM
COLUMM

New i Edit Delete

Clicking new or edit will open a new window that allows defining different types of beam or column
section and assigning properties such as material, geometry, self-weight factor, flexural stiffness factor
and shear stiffness factor. The design type can also be set here and it defines whether the elements
with this section are designed as a beam or as a column.

€ Section Design — O *
. Section Name BEAM _
' Material M20 -
Element Model Timoshenko v I
| Self-Weight Multiplier 1 @
Flexural Stiffness Multiplier 1 @ =] y
| Shear Stiffness Multiplier 1 @ T
Design Type Beam v
| [] Rotate Section
Section Type

EOrTCIreo - F—e—]

Section Properties

Breadth,b (m) 0.2 @ Parameter Value

|| Depthd (m) 04[2]| |- section Ares, A (m?) 8 E-02
MI about axis-y, lyy (m*) 1.0667 E-03
M| about axis-z, lzz {m®) 2.6667 E-04
Torsional Constant, J (m?) 7.3242 E-04

Shear area for Y Shear, Ay (m) 6.6667 E-02
Shear area for Z Shear, Az (m) £.6667 E-02
Radius of Gyration axis-y, rYY 1.1547 E-01
Radius of Gyration axis-z, rZZ 5.7735 E-02

Cancel Save
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8.3 Slab Sections
This tool allows creating, editing and deleting the slab sections defined in the current project. Slab
sections having different material, thickness and self-weight multipliers may be added.

Section List
SLAB | -
49 Slab Section x
Section Mame SLAB
Material M20 ~
Thickness (m) 0125
Self-Weight Multiplier 1 @
Cancel Save

171 1Y

Mew Edit Delete

8.4 Infill Wall Sections

This tool allows creating, editing and deleting the infill wall sections defined in the current project.
Infill wall sections having different material unit weight, thickness, opening percentage, and
brick/mortar compressive strengths may be added.

@ Infill Wall Section X
Section MName IW_SECT

Unit Weight 20 [
Thickness (m) 0232
Cpening Percentage 30 @
Brick Compressive Strength (kM/m7) 10 @
Maortar Compressive Strength (kN/m®) 4@

Cancel Save
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8.5 RC Wall Sections

This tool allows creating, editing and deleting the reinforced concrete wall sections defined in the
current project. RC wall sections having different material, thickness and self-weight multipliers and
stiffness multipliers may be added.

G RCWall Section X
Section Mame RCW_SECT

Material M20 ~
Thickness (m) 01255
Self-Weight Multiplier 11
Flexural Stiffness Multiplier 0.8@
Shear Stiffness Multiplier [}.4@

Cancel Save

8.6 Seismic Loading
This window lets the user select the method of earthquake analysis, seismic design code its various
parameters, accidental eccentricity and the number of modes (for response spectrum analysis).

49 seismic Loading X

Earthquake Load

Building Code

Method of Analysis

NEC 105:2020 -

Maodal Response Spectrum Methad

Site Subscil Category | Type D -
Seismic Zoning Factor 0.35 @
Impaortance Factor 1 @
Crerstrength Factor 15 @
Ductility Factor 4 @
Max Number of Modes 12@
Accidental Eccentricity (%) 10 @
Cancel OK

18



8.7 Load Combinations

This window allows the user to select the load combinations for which the analysis is to be
performed. Default load combinations for the currently selected analysis code can be added using
the Default button.

Each load combination may have 5 different load factors: dead load, live load, storage live load,
earthquake load X and earthquake load Y.

4 Load Combinations X
Load Combinations Name 1201 + 15LL
1.2DL + 1.5LL
DL + 06LL(S) + 03LL +| ~ Dead lLoad L
DL + Q.6LL(S} + O.3LL - Live Load 1.5

DL + 0.6LL(S) + 0.3LL +

DL + 0.6LL(S) + 0.3LL - Storage Live Load 1,5

ECQ Load X 0
EQ Load ¥ 0
Add Delete
Default Open Save As Cancel Save and Close

8.8 Node Loads

In this window, users have the option to create point load that is to be applied directly to the nodes.
The force or moment may be applied in the global X, Y or Z direction, and it may be dead load or live
load. The IDs of the nodes to be added has to be entered, separated by commas, in this window. The
nodes may also be selected graphically and the list of selected nodes will be shown here.

€9 MNodal Point Loads - Od >
Load List Load Name  PL1
PL1 Load Type Load Direction -~ Load Case
FL2 ® Force [ ®) Dead
) Moment Oy O Live
O
Load Value 0
Nodes
Add Delete Save and Close Cancel

19



8.9 Element Loads
8.9.1 Point Loads

Point loads can be defined with different magnitude, direction of application and load case (dead or
live). The distance is a factor between 0 and 1 where 0 is the start node and 1 is the end node.

4
Load List Load Mame PL2
PL1 Load Type Load Direction  Load Case
{ | PL2 ® Force O X ®) Dead
; O Moment O O Live
w7z
Load Value 1]
Distance (0-1) 0
Elements
Add Delete Save and Close Cancel

8.9.2 Distributed Loads
Distributed loads can be defined with different magnitude, direction of application and load case

(dead or live). The distance is a factor between 0 and 1 where 0 is the start node and 1 is the end
node. Load value at each distance point should be mentioned.

. 4 External Distributed Loads - O *
Load List Load Name DL-I
| DL1 Load Direction Load Case
bLz ® Gravity ® Dead
[ O Local ¥ O Live
) Local Z
Load Values Sort
Distance (0-1) Load Value (kN/m)
0.25 10
0.75 10
Elements
Add Delete

Apply Cancel
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8.10 Diaphragm Constant

This window allows you to add a rigid diaphragm constraint. All the nodes in the diaphragm should
have the same Z coordinate. Diaphragms may be auto generated such that all the nodes at the same
level are placed in the same diaphragm.

€ Diaphragm Constraints — O x
|~ Diaphragm List Mame Diaphragm 0
Diaphragm 0
Diaphragm 1 Nodes
Diaphragm 2 01,23456,7289710,11,12,13,14,15
Diaphragm 3

Delete Add Auto-Generate Cancel Apply
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9 Assign
This menu is used to assign sections to the structure elements. The sections must be defined first
using the Define menu. Following structure elements can be assigned from this menu.

Analyz= Design  Cutput Di

Beam/Column Section .
Slab Section

Infill Wall Section

RC Wall Section

9.1 Beam/Column Section
This command assigns a beam/column section to the selected line elements.

@ Assign Section >
Section | BEAM -

Elements 702, 203, 204

Cancel Assign

9.2 Slab Section

This command assigns slab sections to selected slab elements.

9.3 Infill Wall Section

This command assigns infill wall sections to selected infill wall elements.

9.4 RC Wall Section

This command assigns RC wall sections to selected reinforced concrete wall elements.
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10 Analyze
After completion of the model formation, the model can be checked for errors and analyzed based
on selected code.

Design  Output

Check Model
Run Analysis

10.1 Check Model
It checks the model and reports any errors that may prevent the analysis from successful
completion. The following errors are checked.

The number of nodes in the model must be greater than zero.

The total number of line elements and RC Walls must be greater than 1.

The number of supports must be greater than 1.

All infill walls must have 4 nodes that lie on the same plane.

All slabs must have at least 3 nodes, and all nodes must lie on the same plane.

All slabs must have at least one edge shared with a line element for load distribution.

Nou ks wnNR

At least one load combination must be present.

10.2 Run Analysis

If no errors are found in the model, this command runs an analysis for the model.

The progress and output of analysis is shown in the Output panel as the analysis is carried out. Any
errors that occur during the analysis is also reported in the Output panel.

Cutput > 1
16:89:24.227 Floor 4: Fx = 338.58kN, Fy = 338.58kN

16:@9:24.227 Calculating nodal seismic loads

16:09:24.264 Nodal forces calculated

16:99:25.646 Seismic analysis complete.

16:89:25.647 R5A Base Shear ¥=981.3124kN

16:89:25.648 R5A Base Shear Y=1282.9433kN

16:99:25.648 Scaling RSA X results by 1.1682

16:@9:25.65@ Scaling RSA Y results by 1.1431

16:09:25.654 Analysing for Accidental Eccentricity (18%)

16:09:27.186 Mode combination completed

16:09:27.112 Starting Static Analysis

16:@9:29.836 Static Analysis Complete

16:89:29.837 Analysing combinations

16:@9:29.85@ Analysis complete for load combination 1.2DL + 1.5LL[1.2DL + 1.5LL + 1.5LL(5)]

16:99:29.883 Analysis complete for load combination DL + @.6LL(S) + @.3LL + EQX[1.8DL + @.3LL + @.6LL(5) + 1.@EQX]
16:89:29.981 Analysis complete for load combination DL + @.6LL(S) =+ @.3LL - EQX[1.8DL + @.3LL + @.6LL({5) - 1.8EQX]
16:89:29.933 Analysis complete for load combination DL + @.6LL(S) + @.3LL + EQY[1.8DL + @.3LL + @.6LL({5) + 1.8EQY]
16:09:29.96@ Analysis complete for load combination DL + @.6LL(S) + @.3LL - EQY[1l.8DL + @.3LL + @.6LL({5) - 1.8EQY]
16:39:29.968 Combining results

16:89:29.962 Calculating Storey Drifts

After analysis, the model is locked so that it cannot be modified. To unlock the model, press the
lock icon in the main toolbar. Unlocking will delete all analysis results.
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11 Design

Design | Cutput  Display Help

Design Parameters

Leee | . vy vz x7 | GRID | 151 = 1511

| Design Load Combinations

| Beam/Calumn Design Load Combinations

-

Design All Members

Interactive Beam Design

Interactive Column Design

Automatic Detailing

11.1 Design Parameters

In this window, all the parameters for the design of beams and columns can be defined.

€9 Design Parameters et

Design Code

NBC 105:2020 ~

Beamn Design

Clear Caver (mm) 25.0 5

Min. Bar Diameter (mm)
Max. Bar Diameter (mm)
Stirrup Diameter (mm)

Column Design

Clear Caover (mm) 40,0 5
Min Steel Area (%) 0.80 =
Min. Bar Diarmeter {mm) 12 >~
Max. Bar Diameter {mm) 25 ~

Lateral Tie Diameter (mm)

Column/Beam Capacity Ratio | 1.20 |5

Cancel Apply
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11.2 Design Load Combinations

In this window, the load combinations to be used for the design of beams and columns can be
selected.

4} Bearmn/Column Design Load Combinations et

1.20L + 1.5LL {1.20L + 1.5LL + 1.5LL(5))

DL + 0.6LL(S) + 0.3LL + EQX (1.0DL + 0.3LL + 0.6LL(S) + -
DL + 0.6LL{5) + 0.3LL - EQX (1.0DL = 0.3LL + 0.6LL(S) - 1/
DL + 0.6LL{S) + 0.3LL + EQY (1.0DL + 0.3LL + 0.6LL(S) + 1
DL + 0.6LL{S) + 0.3LL - EQY (1.0DL + 0.3LL + 0.6LL{S) - 1.

|:| Select/Unselact All Cancel Save

11.3 Design All Members

This software carries out design of all reinforced concrete beams and columns present in the model
and computes the reinforcement required.

This step may only be carried out after analysis is successfully performed. Results of the design can
be viewed in the Interactive Design windows, and the longitudinal rebar percentage can be shown
using the Display->Rebar Percentage menu.
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11.4 Interactive Beam Design
The interactive beam design allows the user to perform the design and detailing of beams while
interacting with the drawings.

To enter interactive design, select one beam element on the viewport and open Design->Interactive
Design. Alternatively, you may also click Interactive Design on the context menu that opens after
right clicking on the viewport.

The central portion of the window contains the longitudinal section of the full beam, and the current
cross section is highlighted by a blue box. The current section may be changed by using the left and
right arrow buttons below the L-section view. The cross section view on the right shows the active
cross section.

In the lower left part of the window, the user can change the corner bar diameter and add extra bars
for top and bottom reinforcement.

The shear reinforcement diameter can be changed, which changes the minimum required spacing.
The spacing can then be provided.

The skin reinforcement diameter and number of rows can also be set here.

The changes made to the different parameters are reflected in the drawing instantaneously. Also, if
any parameter renders the section unsafe it is highlighted in the warning section. The drawings can
be exported to DXF by Export Drawing button.

The Auto-Design button recalculates all the parameters (bar diameters, number and spacing) such

that the design requirements are satisfied. After the design is complete, press Save and Close.

€ Interactive Beam Design - ] *
g

Section Information

Element ID: 90
Section Location: OL

Design Positive BM: 7.503 kNm

<] [>] Export Drawing | | Auto-Design Design Negative BM: 11,643 kNm
| N . Design Shear Force: 14.754 kN
Top Reinforcement = Bottom Reinforcement = Shear Reinforcement Design Torsion Moment: @ kNm
Corner Bar Diameter 12 Corner Bar Diameter 12 Diameter 8 @
| Top Reinforcement: 0.17%
Extra Bars Extra Bars i i P
N N Required Spacing 89.25 Bottom Reinforcement: 0.17%
Diameter Diameter . -
Spacing 85 @
] Warnings
Skin Reinforcement
Diameter 8 E
Rows 0 @
Required Area 136mm°* Required Area 136mm* Required Area  0.00mm’®
oK Cancel Save and Close

Provided Area 226.19mm*

Provided Area 226.19mm*

Provided Area  0.00mm’
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11.5 Interactive Column Design
Similar to the interactive beam design, this window allows you to perform the design and detailing
of RC columns while interacting with the drawings.

On the left side of the window, the longitudinal section of the column is shown, with the current
section highlighted by a blue box. On the right, the current cross section is shown along with the
design loads. The additional tie can be moved using the In and Out buttons below the cross-section
view.

The reinforcement parameters can be changed in the center portion of the window. If any of the
parameters do not satisfy the design requirement, warnings are shown. The changes made here are
reflected in the drawing automatically. Drawings can be saved to DXF using the Export Drawing
button. After the design is complete, press Save and Close.

49 Interactive Column Design — O =
g

Longitudinal Reinforcement Section Information

Corner Bar Diameter 12

Extra Bars

Diameter

12

Required Area  720mm*
Provided Area 904.78mm*

Transwerse Reinforcement

Diameter 8 @

Required Spacing  192mm Move Additional Tie | In Out
Provide Spacing 190 @ Element ID: 2
Confining Reinforcemeant Design Load Combo: 1.5DL + 1.5LL + 1.5LL{S)

Design Axial Force: 34937 kN

Design Moment ¥: 5.364 kNm
Provide Spacing ?0@ Design Moment Z: 5.364 kMNm
Design Shear Force: 14.822 kN

Required Spacing 72mm

Warnings

Longitudinal Reinforcement: 0.8%

OK | Cancel Save and Close

Export Drawing || Auto-Design

11.6 Automatic Detailing

This command is for calculating all the necessary reinforcement required for each of the elements
present in the model with a single click. After this command is executed, the user can export all the
beam and column drawings from the Output > Drawing menu.
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12 Output

Cutput | Display Help

| | Tables k Seismic Loads

Drawings ] Reactions
Storey Drift and Stability Index

Output | Display Help
Tables s lan ser | A L vy w7 v
| Drawings ] Beamn Drawings

Column Drawings

From this menu, the design output can be displayed in table format and drawings can be exported to
DXF which can be opened and edited in other CAD applications.

12.1 Tables

12.1.1 Seismic Load
This table shows information about the seismic load that was calculated during the analysis.

49 seismic Loading - O X

Z(m) H(m) Floor Height (m) Mass(kg) Weight (kN) StiffnessX (kN/m) StiffnessY (kN/m) CM X (m) CMY(m) CRX(m) CRY (m) Ed

3.00 | 3.00 3.00 | 57703191 365.873 107,331.263 107,331.263 4.500 4.500 4.500 4,500
6.00  6.00 3.00 | 5770319 365.875 107,331.263 107,331.263 4.500 4.500 4.500 4,500
.00  9.00 3.00 | 52,196.724 511.875 107,331.263 107,331.263 4.500 4.500 4.500 4,500
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12.1.2 Reactions
This table displays the reactions generated in all the supports of the model, for all load

combinations.

-é-Reactinn-s - - O x
Load Combination | 1.9DL + 1.5LL + 1.5LL{S) “

Node Rax (kM) Ry (kM) Rz (kM) M (kMNm) My (kNm) Mz (kNm)

0 1.505 1.505 109.484 -1.483 1483 0.000

1 1.505 0.502 198.253 -0.494 1483 0.000

2 1.505 -0.502 198.253 0404 1483 0.000

3 1.505 -1.505 109.434 1483 1483 0.000

4 0.502 1.505 198.253 -1.483 0494 0.000

3 0.502 0.502 335.631 -0.494 0494 0.000

6 0.502 -0.502 335.651 0.494 0.494 0.000

7 0.502 -1.505 198.253 1483 0494 0.000

a -0.502 1.505 198.253 -1.483 -0.494 0.000

9 -0.502 0.502 335.631 -0.494 -0.494 0.000

10 -0.502 -0.502 335.651 0.494 -0.494 0.000

1 -0.502 -1.505 198.253 1483 -0.404 0.000

12 -1.505 1.505 109.484 -1.483 -1483 0.000

12.1.3 Storey Drift
This table shows the drift occurring in each storey of the model, and also shows whether the drift is

permissible according to the selected seismic design code.

4 storey Drift — O *
£(m) H(m) Floor Height (m) Absolute Dnft X (m) Absolute Drift ¥ (m) Relative Drift X (m) Relative Drift ¥ (m) Drift Permissible?
3.00  3.00 3.00 0.002957 0.002957 0.002957 0.002957 v
6.00  6.00 3.00 0.006468 0.006468 0.003511 0.003511 o
000  9.00 3.00 0.008844 0.008844 0.002376 0.002376 o

12.2 Drawings

With this command, the user can export all the beam drawings and the column drawing of the

model in DXF format.
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13 Display

Display | Help
Undeformed Shape ¥7 | GRID | 1.5M1 + 1.5

| Force Diagrams b MNone
Deformed Shape Axial Force
Change Deformed Shape Scale Shear ¥
Amimate Deformation Shear 7
Moment X
Mode Shape
- Moment ¥
Animate Mode Shape
Maoment £

Support Reactions
Slab Load Distnibution

Rebar Percentage
Concrete Detailing

13.1 Undeformed Shape

This sub menu clears all the parameters show in the view window and only shows the undeformed

shape of the model.

13.2 Force Diagram
This menu has commands to display axial force, shear in Y direction and Z direction and moments in
X, Y, Z directions of each structural elements of the model.
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13.3 Deformed Shape
Base on the deformed shape scale, this sub menu displays the deformed shape of the model in the
view window.
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13.4 Change Deformed Shape Scale

This is a tool to change the deformed shape scale. The displacements shown in the viewport will be

scaled by this value for visualization.

13.5 Animate Deformation
This tool allows the user to animate the deformed shape. If the deformed shape is not shown, this
command does nothing. If the deformed shape is being animated, this command will stop the

animation.

13.6 Mode Shape

This command will show the mode shapes computed using modal analysis. Mode shapes are
available only after response spectrum analysis. Select the mode number and scale and then press
Apply to show the mode shape. Check the Animate checkbox to animate the shape.

4p Display Mode Shape x
Made Meone -
Scale 100 (&

[ ] Animate Close Apply

1: T=1.085129s, f=0.92155Hz

| L 4 L L L
e Ean] rr rrm A ana] e kan] rrr

13.7 Animate Mode Shape

Animate mode shape command animates the currently shown mode shape. If no mode shape is
shown, this command does nothing. If a mode shape is being animated, this command will stop the

animation.
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13.8 Support Reactions
This command displays the computed reactions for the current load combination in all supports.

Support Reactions

T T ™ T
Fx = 1.5847 Fx = 1.5847 Fx = 1.5847 Fx = 1.5847
Fy = 1.5847 Fy = 8.5016 Fy = -8.5816 Fy = -1.50847
Fz = 109.4836 Fz = 198.2531 Fz = 198.2531 Fz = 109.4836
Mx = -1,483 Mx = -0.4943 Mx = 9.4943 Mx = 1,483
My = 1.483 My = 1.483 My = 1.483 My = 1.483
Mz =@ Mz =@ Mz =8 Mz =@

13.9 Slab Load Distribution

This command shows the distribution pattern of the slab loads (dead and live) to the beams.

Slab Load Distribution

DL=4.688kN/m DL=4.688kN/m DL=4.588kN/m
DL=4.688kN/m DL=4.688kN/m DiL=4.688kN/m
ll)l =4 . 688kN/m l;)l -4 . 688kN/m (l)l -4 . 6B8kN/m
! ¢ ! )
ErrT [ i o e
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13.10 Rebar Percentage
This command displays the required longitudinal rebar percentage for all designed reinforced

concrete beam and column sections.

Rebar Percentage

9.17% 0.17% 0.17% _ 0.17% 0.17% 0.17% _ 0.17% 0.17% 0.17%

@.17% 0.17% @.17% | 0.17% 0.17% 0.17% | 0.17% 0.17% 0.17%

b s0% 0. 90% o oex b.s0%
0.25% 0.17% 0.26% | 0.26% 0.17% 0.26% | 0.26% 0.17% a.25%
8.18% 0.17% 0.17% | 0.18% ©0.17% 0.13% | 0.17% 0.17% 0.18%

b 8% 1 .5a% h.sax . s0%
9.28% 0.17% ©.31% | 0.30% 0.17% 0.30% | 0.31% 0.17% 0.28%

0.22% 0.17% ©.20% | 0.22% ©.17% 0.22% | ©.20% 0.17% 0.22%

. 0% h.53% 1.53% 0. 30%

13.11 Concrete Detailing
This command shows the reinforcement assigned to each element in the model. Reinforcement may
be assigned through Interactive Design or Auto Detailing.

Concrete Detailing

2120 2128 2120 2120 2120 2120 22120 2128 2120

2120 21280 2120 21120 22120 2120 22120 211208 2120
8120 8128 8120 120

208 2128 2120 2126 220 2120 2120 2128 2120

208 2126 2120 2126 220 2120 2120 2128 2120
8120 5160 8-160 5120

2120 21286 3120 3120 2120 320 328 2120 2120

2120 2206 2120 22126 2120 2120 221280 21120 21209
8120 8168 8-168 8120

* J

T T ™ T

33




14 Help

Check for Updates !
About

14.1 Check for Update
It checks whether a new version of SW FEAD is available for download. If update is available, the
user can log-in using their Softwel Account and download the updates.

14.2 About

It displays information about the software, and the currently installed version.
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